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The Chinese called it Shih Tao, the ancient Celts called it Runa 
futhark, the Mayan Indians called it Kami-a-hota, and the Japanese 
called it Ishido. Yet, regardless of origin, when translated the names 

all mean one thing, The Way of Stones. From the first move, this | 
ancient game and beautiful puzzle recalls the ae of chess 
simplicity of Go. Ishido will call upon your deepest 
and concentration as you match 72, stones.on a ha 
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The man of Tao 

remains unknown 

Perfect virtue 

produces nothing 

No self is true self 

And the greatest man 

is nobody 

— Chuang Tzu 



One misty spring morning in 1989, in the 
remote mountains of China’s Han Shan province, a 
mendicant monk of the Northern School of the White 
Crane branch of Taoism walked silently out through 
the front gates of the Heavenly Peak Temple. 

The monk carried a stone board, a set of 
seventy-two carved stone pieces, and an ancient scroll 
inscribed with brush and ink in elegant calligraphic 
script. 

He also carried with him a secret which had 
lain cloistered and hidden for thousands of years. 

The enigma first surfaced in 1961 - 
when an archeological dig in the Sarsen 
district of northern England uncovered a 
stone board buried among Druidic remains. 

The board, which was later carbon- 
dated to before the Wessex Bronze Age, had 
ninety-six squares etched into its surface, 
arranged twelve squares across by eight 
down. Fragments of what appeared to be 
runestones inscribed with strange characters 
were found in a pile close by, gathered in 
such a way that they might once have been 
held in a pouch of leather or bark that long 
ago had rotted to dust. 
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A few months later a board of similar 
design was found in the sarcophagus of an 
obscure Egyptian Pharaoh. And a few 
months after that, another board was discov- 
ered at the site of a previously unexplored 
Hopi pueblo in central New Mexico. 

Through the course of the 1960s, 
stone boards of remarkably similar design 
and dimension were uncovered in the Israeli 
desert (accompanied by stone fragments 
engraved with Kabbalahc icons), in a cave in 

the Nepalese highlands, in a Mayan pyramid, 
and on a backwoods path in northern Japan 
beside an altar to the nature spirit Izanagi. 

Historians and archeologists, trying to 

make sense of these findings, conjectured an 

explanation for the boards based on refer- 
ences from ancient writings. Apparently, a 

system of philosophy and divination based 

ona “Rule of Four” had sprung up separately 

in several of the world’s ancient civilizations. 

Although archeological technologies dated 
the boards back to disparate times and 
locations, each version could be traced to a 
similar seminal point in the evolution of the 

individual culture that had created it. 



Every culture visualized and described 
the “Rule of Four’ in its own way: 

y < ; 
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Four Stones Meditation « Way of the Four Winds « The Fourth Oracle 

Se 
Path of the Four Directions ¢ Four Point Runic Cross 

Over the past 28 years, archeologists, 
mythologists, philosophers, and historians 
have tried to make whole the puzzle of the 
stones, learning what they could from frag- 
ments of stone and writings gathered the 
world over. 

And now, through the instrument of a 
lone anonymous Taoist monk, the answer 
has finally been provided. 



es 
He called himself Fei Mi-jai, though there is no 

reason to believe that was his real name. He described 
himself as just a monk, without station or status at 
the monastery. He had been brought there when just 
a child, and assigned the daily practice of carrying 
water from the well and chopping wood for the fire. 
He was told that task would remain his only practice 
until he had mastered it fully. 

He would be forty years incarnate on the full 
moon this May. But his practice had yet remained 
unchanged. 7 

One day the Grand Master approached Fei 
Mi- jai with a special task. First he handed the monk 
a faded rice-paper scroll. Then, placing the sacred 
temple stones in the monk’s hand, he gave him this 
instruction: “Take these and walk to the River of 
Dolphins. When you reach it, continue along its 
banks until you come to a confluence of time and 
space, when/where the silence is louder than the river 
rapids. Then sit there and wait. Give the stones to the 
very first person who happens by and tell him about 
them. When you have completed this task, return to 
the monastery immediately!” 

The monk ventured forth and did exactly as he 
was told. He found the confluence and sat there in 
meditation. Eight days he sat without moving until, 
finally, a solitary stranger passed his way. 
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This man was taller than most, and the monk 
(who was schooled in the Ways) recognized him 
immediately as the sorcerer Ehsarai. When their 
gazes met, the sorcerer’s eyes began glowing the color 
of “rare blue jade.” And in those eyes the monk could 
see the reflection of his own eyes, and that they, too, 
were glowing the color of morning sky. In that 
instant a dolphin burst through the river's surface 
and somersaulted into the air, chirruping a joyous 
song of life. 

As one the two men sat upon the earth, and 
Fei Mi-jai prepared a pot of tea. They drank in 
silence, contemplating the sound of currents lapping - 
at the river's edge, and absorbing the warm sunlight 
reflecting off its surface. | 

Then the monk unrolled the crumbling 
parchment, and readied to tell the tale. 



Those familiar with Chinese metaphor 
will recognize the tall, blue-eyed “sorcerer” as 
a westerner. Whether sorcerer or not, a 
magician of some sort was still required to 
receive the stones, carry them across the 
Great Ocean, and give them back to the 
world. | 

Keep in mind that the myth recounted 
here is a Chinese rendition, and that each 
culture — whether Japanese, Native Ameri- 
can, Egyptian, Mayan, Hebrew, or other — 
weaves the tale somewhat differently, using 
characters and symbolism drawn from its 
own cosmology. As mythologist Joseph 
Campbell reminded us: though told in many 
voices, there is but one myth. 

The Chinese called it Shih Tao, the 
ancient Celts called it Runa futhark, the 
Mayan Indians called it Kami-a-hota, and the 
Japanese called it Ishidé. Yet, regardless of — 
origin, when translated the names all mean 
one thing, The Way of Stones. 

What follows is the Legend of the Stones, 
as transmitted by Fei Mi-jai to Ehsarai. 
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In a voice strong and clear, he began the telling 
by chanting the ancient verses: 

Life, when it came to be, 

Bore one, then two, then three. 

And thus the three began: 
Heaven and earth and man. 

And when wont to seek life’s core, 

the Tao gave them the Rule of Four. 

I 

The Winds 

north and east 

south and west 

2 

The Elements 

earth and air 

fire and water 

3 

The Seasons 

winter and spring 

summer and fall 

4 

The Oracles 

yarrow and bone 

tortoise and stone 



Before the time of the Yellow Emperor, 

before even the time of Fu Xi, the stones 

came to this world as the Fourth Oracle. And 

as would be most appropriate for the fourth 

stage of the fourth group of the Rule of Four, 

the stones evolved through four incarnations: 

first as the Oracle of the Stones, next as the 

Meditation of the Stones, then as the Art of Stones, 

and finally as the Ancient Game of Stones. 

The Fourth Oracle, the Oracle of the 

Stones, came to be known simply as “the 

stones.” The stones were no ordinary oracle. 

To consult them one needed only to touch 

them, to hold them, to be with them, to 

become one with the colors, shapes, and 

symbols that formed their lexicon. The 
stones were experienced by the faithful as a 

living presence, and when one learned their 

language they would speak directly — 
earth’s heart to human heart. 



The stones worked by mirroring the 
magic of the subconscious mind. Thus, 
they never absolved questioners of the 
responsibility of selecting their own future, 
and never could be corrupted into mere 
fortune-telling tools. 

Rather, they pointed attention toward 
those hidden fears and motivations that, 
unknown to questioners, were invisibly 
shaping their future. Once their presence 
became evident, these unseen factors could 
then be absorbed by the questioner into the 
realm of free choice. 

Consulted by princes and peasants 
alike, the stones provided an intuitive, 
naturally balanced foundation upon which 
primal civilization could successfully base 
its survival. They were the voice of the Tao 
itself: clear, compassionate, unflinchingly 
direct, and honest. Out of love for the 
wisdom and beauty of the stones, dedicated 
believers devoted years, even lifetimes, to 
elevating their communion with the oracle 
to perfection. 

And for a brilliant, shining moment 
in time, the earth and all its inhabitants 
vibrated to a single harmonic chord. 



But the music would not last forever. 
In time there arose a group of clerics who 
became self-professed experts in the way of 
stones. They began by teaching the way to 
others. But, eventually, they turned to charg- 
ing fees to interpret the stones for those who 
had neither the patience to consult the 
stones themselves, nor the realization that 
the wisdom of the stones could not be trans- 
mitted except through direct experience. 

The power and influence of these 
usurpers, who insidiously called themselves 
the “Masters of the Stones,” spread quickly... 
for they took that which the stones once gave 
freely to all and claimed it for themselves. 
Thus the Oracle of the Stones became lost to the 
very ones for whom it had originally been 
intended. 
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Humanity, in its vanity, distanced 
itself from the Way. The ancient harmonies 
became muted, and the stones came once 
again to be perceived as inert objects, mere 

concretions of mineral matter, useful only to 

prop the corner of a derelict hut, define the 
boundary of a cooking fire, or clobber a 
startled pheasant for the evening's meal. 

And the era of the Oracle of the Stones 
drew to a close. 

Fei Mi-jai stopped a moment to watch a 
hummingbird, hovering nearby, extract nectar from 
a white orchid. As the tiny bird whizzed off, the monk 
turned his attention back to the sorcerer, and contin- 
ued with his story. 

“ 
Generations after the oracle had been 

silenced and forgotten, a young man named 
Shih Tzu came to live alone on Spirit Cloud 
Mountain. As a youth he had seen the shape 

of things, and finding little there to interest 
him, chose to leave the world behind. More 

than a decade had passed, and now the 
hermit Shih Tzu was approaching his thirtieth 

year. 
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To him the mountains spoke in ways 
his human counterparts could never hope to 
match: in breezes commingling with pine 
cones, in springs gurgling and sparkling as 
they meandered hither and fro, in lightning 
sparring with heavenly ramparts in spectacles 
of awesome power. | 

One ordinary day — ordinary only in 
that it was no less extraordinary than all the 
rest — Shih Tzu sat leaning contentedly 
against a gnarled and ancient pine. The 
sound of waterfall was a constant calming 
music and the cool, pure air had awakened 
his senses to crystal clarity. 

His mind was as empty as the cloudless 
sky when he noticed a stone beside his 
sandaled foot. It had a peculiar shape, a 
distinctive translucent blue color, anda 
rather remarkable marking across its face. 
He bent over, picking it up to examine it 
more closely. 

He held it first in one hand, and then 
the other. He sniffed it, and licked it, then 
rubbed it across his grizzled cheek — feeling, 
he thought, a pulse so deep and wondrous 
that his own heart’s rhythms were drawn into 
EP with the cadence. It was alive! He could 
eel it! 
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And then he was gone, gone to a place 

no mortal had ventured before; gone so far 

he completely lost track of who he was and 

from where he had come and why he should 

even be at all. 

When he awoke his body was buried in 

years of leafy droppings fallen from the 

venerable pine. His beard — extending 

below his navel — was grayer than it was 

black. Rising upon the shaky legs of his now 

gaunt frame, he descended directly from his 

mountain perch to the valleys below. 

And the age of the Meditation of the Stones 

had begun to dawn. 

A sudden “Caw! Caw!” issued from a passing 

crow, drew Ehsarai’s attention for an instant. Then 

the sorcerer locked eyes with the monk once again, and 

the storyteller continued. 

He 
Wearing tattered robes and sandals 

worn bare from walking the dung-covered 

roads, Shih Tzu wandered from village to 

village. He had little to say, and so said 

little. Entering an enclave of peasant hovels, 

he would search for the corner of the village 

square left least adorned by the cows and 
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swine, then sit himself down, arranging his 
legs in the lotus position. 

With great deliberation, and without 
noticing those who had paused to notice 
him, he opened his shoulder bag and 
removed the stone board he carried therein. 
Then he drew out a cloth pouch containing 
dozens of similar-sized stones, each varying 
in shape and color and with a primitive 
ideogram etched upon its surface. 

He would hold the pieces in his hands, oe 
fondle them, speak to them, and listen to 
them as if they were speaking back to him. 
Then he would place them, one by one, upon > 

the board. A crowd would gather to watch 
this strange wanderer lost ina worldof | 
stones. : nas 

When the placing of the stones had — 
drawn to a natural conclusion, Shih Tzu 
would sigh deeply, close his eyes, and be 
gone. Gone he would be for hours or days; — 

but when his eyes finally reopened there _ 
would always be at least one villager waiting, 
eyes wide, eager to learn the secret of the 
stones. Shih Tzu would rise silently and _ 
begin walking toward the next village, the © 
supplicants falling in step behind him. 

Twenty-two moons after first coming 
down from Spirit Cloud Mountain, Shih Tzu 
finally returned to his home, hundreds of 
truthseekers following reverently in his path. 
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| Sequestered among the spired peaks, 
the settlement swiftly blossomed beyond 
primitive huts of piled stone into a temple of | 
truth and hope. As time passed it came to be 

~. known as Shih Tao Monastery. 

For over two hundred years, life at the 
mountain retreat reflected the unyielding, 
compassionate wisdom of the Meditation of the 
Stones. It is said that Shih Tzu lived to be two 
hundred and sixty-three years old. 

One sunrise in the autumn of his final 
year, Shih Tzu emerged slowly from the 
humble one-mat cell that had been his home 
since his return to the mountain. He had 
grown so frail and evanescent, there now 
seemed naught but a glow anda whisper to 
his temporal presence. 

He took one step beyond the door 
frame of his hut when — before thought — 
his arm extended out in front of him, palm 

facing skyward. A single flake of snow, float- 
ing unseen from the heavens, landed gently 
-upon his open hand. He stood there trans- 
fixed, watching as it melted and merged with 
his flesh. He seemed to hear a message 
transmitted in the silence of the crystalline 

_ teardrop. | 
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Turning, he shuffled slowly toward a 

sroup of children gathered about their stone 

boards, practicing their meditations. The 

children, feeling the master’s presence lift 

them, merged more deeply with the one than 
ever they had before. 

When they returned to the physical 
plane, Shih Tzu was gone. On the ground 

where he had stood they found a single blue 

stone, opalescent, radiant, and pure. 

Before long, the mountain’s residents 

began to trickle back down to the valleys. 

And the trickle became a torrent, until the 

monastery existed no more. Most took their 

stones with them. But none could manage 

to preserve the meditation practice. And the 

Meditation of the Stones quietly disappeared. 

oN 
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The soul of the stones had been 
left behind, yet their inherent beauty 
transcended the dark veil...for as with all 
objects of power and spirit that have fallen 
into disuse, their essence could still be 
experienced as a palpable presence. The 
few stonesets that survived the arduous trek 
down the mountain were looked upon by the 
multitudes with wonder and awe, and their 
impact on the aesthetic consciousness of the 
people eventually redounded to the farthest 
corners of the kingdom. 

Those who regularly used the stones 
still experienced the calming influence of the 
patterns upon the board. In time, it was : 
discovered that different tableaus generated 
varying effects. Use of the power and beauty 
of the stones began to permeate through a 
remarkable array of unlikely mediums. Ifa 
simple arrangement of stones could evoke 
such a feeling of peace and security, how 
much more the impact if a whole village were 
geomantically laid out along those same 
formations? 

Farmsteads followed suit, utilizing 
crops such as rice, wheat, clover, and soy to 
provide the alternating patterns. Dishes, 
cups, and bowls were fired as squares so 

- propitious tableaus could be created at the 
dinner table. Among the literati even a style 

_ of poetry, using an aberrant interpretation of 
the “Rule of Four’ as its metric cornerstone, 
came into wide vogue. 
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But the most obvious medium for 

artistic expression of the stones’ beauty was 

the stones themselves. Artists and craftsmen 

everywhere turned their spirits and talents to 

creating stonesets of astonishing beauty and 

grace. 

Every manner of stone was put to the 

artisan’s chisel. Stonesets of carnelian, 

azurite, amber, sodalite, bloodstone, and 

quartz were crafted and coveted by the 

burgeoning numbers who peopled the cult 

of the Art of Stones. Perhaps some of the 

most exquisite and subtle of all the stonesets 

were carved of wood — for was not wood of 

the earth itself, issuing as it did from the very 

womb of stone? 

Inevitably, sets came to be made from 

silver and gold and other precious metals. 

And soon they became too valuable to ex- 

hibit in public for fear they would be stolen. 

The trade in stones became brisk and unset- 

tling. Wealth, prestige, power, and influence 

came to be measured by the number and 

kinds of stones one possessed. : 

And it came to pass that the stones, 

once the symbol of an enlightened society 

principled by beauty, became synonymous 

with treachery, corruption, and greed. 

Thus the Art of Stones was reduced to a 

form of currency, and became lost in a flood 

of cascading passions. 
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: 

Fei Mi-jai paused to sip his tea. Then, hands 
folded, palms together in his lap, he continued. 

een 

a. one 

A cloud of dust rising on the horizon 
had come to signify yet another army on the 
march, bringing with it another warlord with 
his horde of looting mercenaries. 

In this time of endless war — pitting 
family against clan, village against town, and 
dynasty against usurper — the stones took 
on new significance. For the “Rule of Four” 
had been perverted into the Ruling Four 
Deities of War: strategy, intuition, patience, 
and chance. 

Power was no longer a responsibility to 
be tempered by compassion and wisdom, but 

| a precondition to wealth by plunder. And as 
| everyone knew, the stones meant power. 

Playing the stones with discipline still 
brought the player to “one-pointed mind.” 
But more than for the calm and focus they 
bestowed upon the player, the stones were 
valued for the role they played in summoning 
the Four Deities to one’s side. 
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The evening before battle the opposing 
generals would invariably be found in their 
respective camps, huddled within their tents 
and hunched over a board of stones. By 
playing the stones, the leaders could divine 
how best to approach the imminent warfare. 

For these men, through an unholy 
convolution of natural law, the stones had 
become oracle, meditation, art, and game all 
rolled into one. 

The wars raged for centuries and the 
populace was decimated. Eventually, the 
only able-bodied men remaining were the 
warlords and generals. And since they never 
deigned to participate in the brutality them- 
selves, there was no one left to do battle. 

So wars came to be settled over a game 
of stones. To the winning player went all the 
spoils — including the other player's 
stoneset. 

Fei Mi-jai closed his eyes and drew silent. A 
butterfly flitted about, a bee buzzed past, an invisible 
breeze rippled through the river reeds. Ehsarai sat 
patiently, waiting without stirring for the monk to 
resume his narrative. 
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One man emerged preeminent from 

the wars. He was Wuying Li, and he was a 
master at the Ancient Game of Stones. But he 
was also greedy and ruthless. He challenged 
all he met to.the stones, and invariably left 
them beaten, humiliated, and stoneless. By 
the time of his death he had amassed a 
sprawling empire and a treasury stocked to 
bursting. All this he left to his spoiled, 
insolent son, Wuying Zao. 

| To Zao, his only heir, Li also be- 
-queathed his awesome proficiency at stones. 
Zao played at the “eight 4-Way” level, and few 
were his subjects who could consistently 
achieve even seven. 

When Zao reached maturity he ram- 
paged over the land, and set his acquisitive 
sights on anything his departed father had 
been unable to win or steal. Zao’s stones 
collection grew beyond comprehension. 
After a while he could no longer countenance 
anyone else even owning a set. He declared 
illegal the creation of any new stonesets, and 
went about winning all those that remained. 
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No one could match Zao’s skill at 
stones. And when the day arrived when no 
new challengers came to court, Zao’s pride 
grew to titanic proportions — for he believed 
that every stoneset under heaven was his. 
And so it seemed. 

But rumors came trickling into the 
capital that one stoneset still remained free 
of the tyrant’s possession. Zao would not — 
could not — accept this. He plotted to lure 
the “coward” and his stones from his hiding 
place. 

In his arrogance, Zao announced that 
he would challenge the set’s owner toa 
match, wagering all the sets in his posses- 
sion against his opponent’s one. The chal- 
lenge would remain in effect for one hundred 
days, and then be withdrawn. 

Three full moons and one crescent 
moon later — one hundred days to the hour 
— aman appeared at the gates to the capi- 
tol, stoneboard and pouch in hand. Word 
spread quickly to the palace. 

As the man ascended the palace steps, 
Zao’s heart skipped one tiny beat. But he 
soon was smiling again. For his opponent 
was just an old man. And his stoneset — it 
wasn't platinum, or gold, or ivory, or even 
wood. It was plain stone. 
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A roll of exuberant laughter pealed 
from deep within Zao’s considerable gut, and 
the stench of doom pervaded every corner of 
the city. 

| The old stranger was tall and thin with 
ebony eyes and a long wispy beard. His 
silvery hair was combed up into a topknot 
and held there with a single pin. He wore the 
simple black robe of a Taoist priest. 

The stranger drank tea. Zao drank wine. 
And as was his right as the issuer of the 
challenge, Zao chose to play first. His style 
was to break his opponent’s spirit with a 
dazzling display of virtuoso stoneplay. 

And dazzle he did. Zao was brilliant. 
As ordinary as the old man’s stoneset was, 
Zao still lusted after it like a 17-year-old boy 
during his first night in the brothel. Zao 

~ reached the pinnacle of his skills that day, for 
nothing so moved him as lust combined with 
greed. 
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When he was finished, Zao had 
achieved what no person had ever done 
before: he had emptied his pouch of all its 72 

stones, and he had scored an astounding 
twelve 4-Way matches. 

Looking up in glee to give the old man 

that smug, obnoxious look of feigned pity a 

supercilious winner casts to a beaten oppo- 

nent, Zao was just in time to see the monk 

placing his first stone upon his board. 

That was the last fast move the old man 

made. Lapsing often into deep meditation, 

caressing and rubbing the stones, talking to 

them and placing them to his ears, the old 

man’s game stretched through the night. 

And as dawn began spreading pastel 

colors across the morning sky, the black- 

robed challenger achieved the incredible. 

With his next-to-last stone he, too, played his 

twelfth 4-Way match of the game. 

Zao scanned the board wildly, his eyes 

darting everywhere. “Impossible,” he 

screamed. the echo resounding off the palace 

walls, rudely and repeatedly piercing the _ 

aurora stillness. 
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Indeed, the old man had matched Zao 
on 4-Ways. But the final stone still re- 
mained. If the monk couldn't find a place for 
it on the board, Zao would win. And even if 
the old man could place the stone, the game 
would be a draw and Zao would still be 
declared winner...for Zao had issued the 
challenge, and by accepting it the old man 
= assumed the tacit obligation to better 
im. 

Holding the final stone in both his 
hands, the old man closed his eyes. He 
lowered his head and inhaled deeply, heavily. 
With a slow, deliberate, barely perceptible 
exhalation his body let go a tiny, prolonged 
shudder. It appeared as if the last feeble 
breath had just slipped unwillingly from his 
frail body. And with it, all hope of victory. 

Zao sensed the old man’s defeat. 
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But at the instant the sun’s first rays 

crept above the horizon — casting the 

priest’s shadow the length of the courtyard as 

it bathed his torso in golden radiance — the 

old man suddenly raised his head and 

opened his eyes wide. 

They were glowing the color of “rare 

blue jade.” 

eae 

70 never recovered from the old man’s 

thirteenth 4-Way. 

The old priest claimed Zao’s stonesets 

and had them all destroyed. Then he tucked 

his own tattered pouch of stones into the 

sleeve of his robe, placed the board of plain 

stone beneath his arm, and departed. 

He was last seen walking north toward 

the distant mountains of Han Shan, carrying 

with him the last existing set of stones. 
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| _ Fei Mi-jai finished the story and carefully 
rolled up the scroll. Then, as the Grand Master had 
instructed, he handed Ehsarai the set of stones. 

Both men rose as one and bowed deeply to each 
other. 

The monk turned and quickly disappeared 
upstream into the gathering mist. The sorcerer 
headed east into the brilliant sunshine — his eyes 
aaa by the light, the stones clasped tightly to his 
reast. 3 
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the Way of Stoned 

WELCOME TOISHIDO 
From the first move this ancient game and beautiful puzzle will call upon your deepest 
powers of strategy and concentration as you match 72 stones on a board of 96 squares. 

You can play for points, compete against the clock, or kick back and meditate over each 
move with the deliberation of a Master. See if you can outdo your own best score in 
progressive games, and learn the secret of 4-Ways. 

Design your own stonesets, backgrounds (and boards in the color version), using Ishid6’s 
sophisticated graphics editors and/or your own paint and draw programs. 

Let the Oracle guide you as you play against the computer or challenge your friends. 

As your strategy improves you will have a chance to discover what’s at the heart of Ishid6é 
and why, to some, the Way of Stones is far more than a game. 

GETTING STARTED 

SYSTEM REQUIREMENTS 

Here’s what you need to play Ishido: 

For Macintosh SE or Mac Plus 

You need one megabyte of internal memory (RAM). 

Hard drive is optional. However, without a hard drive you can only play with two of 
Ishid6’s four sounds (the “stone click” and “4-Way match” sounds). 

For Macintosh II 

You need a Mac II with a hard drive and a minimum of 2 megabytes of internal memory 
(RAM). As with other applications, the more RAM you have, the cleaner and faster 
your game will perform. 

To initially install the entire color game on your hard drive you will need 4.5 megabytes 
of free disk space available. After installation the entire game will use about 3 megabytes 
of disk space; this can be reconfigured down to as little as 1.2 megabytes according to 
your personal tastes. 

l 
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UsER REQUIREMENTS 

Mac Plus, Macintosh SE, or Macintosh II 

Before you start playing the Macintosh version of Ishidé, you should know how to: 

e Use the icons on the Macintosh desktop. 

e Open and close Macintosh documents and folders using the Finder. 

e Point and select with the mouse, and understand basic Macintosh terms and 
techniques such as click, double-click, and drag. 

e Scroll in a window or list box using the scroll bars and the scroll box. 

e Pull down menus and choose commands. 

e Use the Clipboard and find files in the hierarchical file system. 

You should also understand Macintosh terms such as dialog box, list box, folder, and 
button. For information on any of these items, see your Macintosh owner’s guide. 

WH AT'S ON YouRISHIDO DISKS 

Ishido 1 files: Ishidé Color Program Segment 1 
Ishidé Installation Program 
Ishidé Sounds 

Ishido 2 files: Ishidé Color Program Segment 2 

Ishido 3 files: Ishidé B/W Program 
Ishid6 Help 
Ishidé Oracle 

LOADING INSTRUCTIONS 

Your Ishidé disks contain two stand-alone applications, the color and black & white 
game programs. They both share the sound, help and oracle files. 

Installing the Black & White Program on a Mac SE or Mac Plus 

If you have a hard drive: 

1 Insert the Ishid6 1 disk into your disk drive and display its contents. Copy the Ishido 
Installer (copy to HD) application onto your hard drive. Leave the Ishid6 1 disk in 
the drive. 

2 Double-click on the Ishido Installer application that you just copied onto your hard 
drive. 

3 When the Ishido Installer screen is displayed, select “Install Black & White,” then 
click on the Install dialog button. 

When prompted, insert the Ishidé 3 disk. 

When installation is complete, click on the OK Dialog button. 

NO Nn Select Quit from the Installer Screen. 
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7 To start a game, open your Ishidé folder and double-click on Ishidé 1.1 bw. 

If you don’t have a hard drive: 

1 Insert the Ishid6é 3 disk into your drive and display its contents. 

2 Double-click on the Ishidé 1.1 bw icon to begin play. 

Installing the Color Program on a Macintosh II 
To install the entire color game on your hard drive you will need 4.5 megabytes of free 
disk space available. After installation and removal of extraneous files the entire game 
will require about 3 megabytes of disk space. 

You can reconfigure this down to as little as 1.2 megabytes according to your personal 
tastes by using the Ishidé Mover described below (THE ART OF STONES, Moving 
Stonesets, etc). 

1 Insert the Ishidé 1 disk into your disk drive and display its contents. Copy the Ishido 
Installer (copy to HD) application onto your hard drive. Leave the Ishid6é 1 disk in 
the drive. 

2 Double-click on the Ishido Installer application that you just copied to your hard 
drive. 

3 When the Ishido Installer screen appears, select “Installer Color” and click on the 
Install Dialog button. 

When prompted, insert Ishidé 2 disk, then Ishid6 3 disk. 

When installation is complete, click on the OK Dialog button. 

Select Quit from the Installer screen. 

ND Wi pb To start a game, open your Ishidé folder and double-click on Ishidé 1.1c. 

Using the Ishid6 Codewheel 
After you start the game, Ishidé displays a dialog box asking you to consult the Ishidé 
Codewheel and enter the correct code. Your screen will.show four elements — two 

patterns, two words — and a window to type in. 

1 Match the left-most pattern on the screen to the same pattern on the outer edge of 
the outer ring of the codewheel. | 

2 Now find the second pattern from the left on the screen, and match it to the same 
pattern on the middle ring of the codewheel. 

3 Rotate the middle ring so the second pattern lines up under the first pattern. 

4 Next, find the left-most word on the screen, and match it to the same word on the 
edge of the inner ring of the codewheel. | 



Using the Ishidé Codewheel (continued) 

5 Rotate the ring so the word is lined up under the two patterns. 

6 Look for the second word on the interior of the inner ring; there is a number immedi- 
ately above the word. 

7 Type in that number and press Enter to begin Ishido. 

the lable Cou 

Fig 1. Ishid6 Codewheel 

OvERVIEW 

Ishidé is a board game where you attempt to match stones according to their colors and 
patterns. Ishidé can be played as a solitaire game, by two players, by a player against the 
computer, or even by the computer itself (this is useful to see how the computer thinks). 
You can also play cooperatively to achieve a high score, or competitively. 

Ishid6 has several unique features: You may consult the Oracle during the game to 
answer questions, and you can select from amongst several different boards and stonesets, 
or even create your own stoneset. 

The following section gives you a tour of the game board, then discusses how to begin 
and play a typical game. Next, the manual outlines each of the commands and options 
available in Ishidé. Hints and strategies follow, and finally, the Stoneset editor is ex- 
plained in detail. 

If you’re impatient with reading rules and want to start playing with a minimum of fuss 
and bother, read the Beginning Play section and go to it. You'll find most of the menu 
items to be fairly obvious. 

Your first games probably won’t score well unless you read the Strategy section, though. 
Once you have experienced The Way of Stones, come back and read the entire manual. 
There is much in here to contemplate for you to become a true Master of Ishid6. 

Opening, Ending, and Saving Games 
You can end, save, open saved games, start a game over, or quit Ishidd at any time. Select 
the File Menu and the appropriate command: 
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File Menu Commands 



The Game Board 

The first step in playing Ishid6 is getting to know the board. Follow the steps in the 
Loading Instructions section appropriate for your system to load Ishidé and make the 
game board appear. 

| file Game Options Help High Scores : 

Game Board ; | Touchstone 

The Within 
veeeeeeesee ees EEE PrsteseeeeetsendheseseestesesetesesseseessesedecsensessesseatccnssensessensGuesesesssessssteerssseseesssegeeeeseesecseeretiersersessesss oeeEBEEEEEBER toy 

Scoreboard 

Stones ie PRREPEOEEREEETS «+s occ ecreceae SevseeeeeteetedeneesseeseeseeGiaeseesneensustesseesseeee regs 

ES G3 Co Ga a 6) 

Opening Tableau 

¢ The Menu Bar appears when you click and hold on the top of the screen. It 
consists of &, File, Game, Options, Help, and High Scores. An Edit menu 
appears between File and Game whenever a desk accessory requires its use. 

e The Game Board is eight squares high by 12 squares wide. 

e Stones come in sets of 72 stones. Every stone has two attributes: A background 
color/pattern and a symbol. There are six symbols and six color/patterns in each 
stoneset, thus creating 36 unique stones. Each stone comes in a pair, hence 72 
stones in each stoneset. 

e The Within consists of the light interior squares. | 

¢ The Beyond consists of the dark squares at the outer edges of the board. 

e The Touchstone displays the next stone to be played. You can place a stone on 
the board two ways: by clicking on it once, dragging it from the touchstone to the 
board, and clicking it in place; or by clicking directly on the square in which you 
want the stone to be placed. 

¢ The Scoreboard shows both the number of points scored (at the top), and the 
number of 4-Way matches achieved (at the bottom). 

e The Pouch shows a representation of the number of stones remaining to play. 
Double-clicking on it shows you the stones in detail, and their order in the pouch. 

6 



PLAYING THE FIRST OTONE 
Now that you’re familiar with the board, it’s time to cast the first stone. When the game 
opens and you see the empty game board, select New Game from the File menu. The 
game begins with a unique opening tableau of six stones on the board and a pouch of 
randomly ordered stones. The Opening Tableau consists of stones placed at each of the 
four corners and on the two center squares. Each of the six symbols and six background 
colors (patterns in the black & white version) are represented in the opening tableau. 

The game begins in Solitaire mode with Modern scoring. These settings can be changed 
using the menus. See Menus below in this manual for details. 

RULES OF PLAY 

At each turn, the computer draws one stone from the pouch and displays it on the 
touchstone. Every stone has two attributes: a symbol and a background color (color is 
indicated by a pattern in black & white versions ). 

You'll try to place each stone on the board so that its color/pattern or symbol matches 
the stone next to it. You or other players then continue to place stones until no more 
legal matches are possible or until the pouch is empty. 

Placing Stones 

Point the cursor on the spot you want to place the stone on the board and click once. 
The stone on the touchstone moves to the square you selected. 

You can also move stones from the touchstone to the board by clicking on the stone and 
dragging it to the board. Click the mouse button again to set the stone on the board. 
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Matching Stones 

Place each stone next to (above, below, left or right — but not diagonal to) another 

stone, matching either the color/pattern or symbol with the adjacent stone: 

Symbo 

2-Way Match: To legally place a stone next to two other stones, your stone must match 
one stone with the color/pattern attribute and match the second stone with the symbol 
attribute: 

Legal 2-Way match Illegal 2-Way match 

3-Way Match: To legally place your stone so that it adjoins three other stones, you must 
match two of the stones with one attribute, and the third stone with the other attribute: 

Legal 3-Way match Illegal 3-Way match 
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4-Way Match: After you gain a little experience making two-way and three-way 
matches, try your skill at a four-way match (4-Way). To make a 4-Way, place a stone in 
the center of four other stones, matching two of the stones on one attribute and the 
other two stones on the other attribute: 

Legal 4-Way match Illegal 4-Way match 

Creating a 4-Way 
Creating 4-Ways is the best way to build a winning strategy. They are also the only way 
to receive Oracle auguries (readings). You can learn more about the Oracle in the 
section on Using the Oracle and pick up strategy tips in the Strategy section. For now, 
here are the basics: 

1 Using any chosen stone, start a 4-Way match by placing a stone that matches the 
color/pattern on one side and a stone that matches the symbol on an adjoining side: 



Creating a 4-Way (continued) 

2 Then draw other stones from the pouch and add to the 4-Way: 

3 Only this stone SE can be placed in the center to complete this 4-Way match. 

If you get stuck, take your best guess at placing the next stone...dialog boxes will pop up 
and help guide you if you make a mistake. (See Center Master Play and Master Game 
for more insight into creating 4-Way matches.) 

Just Remember These 4 Simple Rules... 

1 To create a 1-Way match you must match your stone with the stone on the board 
using one of your stone’s two attributes. 

2 To create a 2-Way match you must match your stone using one of its attributes for 
one stone, and its other attribute for the second stone. (Remember: “1 and 1”) 

3 To create a 3-Way match you must match your stone using one of its attributes for one of 
the stones, and its other attribute for the other two stones. (Remember: “1 and 2”) 

4 Tocreate a4-Way match you must match your stone using one of its attributes for two of 
the stones, and its other attribute for the other two stones. (Remember: “2 and 2”) 

ANCIENT AND MODERN WAYS OF PLAYING 

_ There are two ways of playing Ishidé: the Ancient Way and the Modern Way. Each uses 
_a different system of scoring and requires a somewhat different strategy. Either style can 
be selected from the dialog that appears when you choose any of the Game menu 
commands. 
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The Ancient Way...Game and Scoring 
In the Ancient Way of playing Ishid6, the player wins when he or she empties the pouch, 
placing all the stones on the board. The player also creates as many 4-Ways as possible. 

The number of 4-Ways created appears on the lower portion of the scoreboard, next to 
the graphic for 4-Way symbol (4h: ). 

In Tournament and Challenge games, if several players empty the pouch, the player with 
the most 4-Ways wins. If no one empties the pouch, the player with the most 4-Ways 
wins. If no one empties the pouch and everyone has the same number of 4-Ways, the 
player with the fewest number of stones left in the pouch wins. 

The Modern Way...Game and Scoring 
In the Modern Way of playing, the goal is to score the highest number of points. Players 
can get high scores by creating as many 4-Ways as possible, as early in the game as 
possible, as they try to empty the pouch. 

Players receive points by legally placing stones next to other stones in the light, interior 
portion of the board (The Within). The greater the number of sides legally matched, 
the greater the number of points earned. No points are given for stones placed in the 
dark perimeter squares (The Beyond). Strategic use of non-scoring matches is essential. 

Points earned for legal matches are: 

Each 4-Way match earns bonus points and doubles the points awarded for subsequent 
matches. For example, after the first 4-Way, a single-sided match earns two points, a 
two-sided match earns four points, a three-sided match earns eight points, and a 4-Way 
earns 16 points. The next 4-Way doubles the point scheme again, and so on. 

Bonuses awarded after each 4-Way match are: 



The Modern Way...Game and Scoring (continued) 

At the end of the game, bonuses are awarded when fewer than three stones remain in the 

pouch. Bonuses are not awarded in a Challenge game. Bonuses awarded are: 

Since 4-Ways double the points achieved by matches and produce bonus points, a player 

who scores four 4-Ways without placing all the stones can actually score higher than a 

player who does empty the pouch but does not make any 4-Ways. 

GAME MODES 
You can play Ishidé by yourself in the Solitaire mode, or test your abilities against others 
or the computer in the Challenge and Tournament modes. If you’re feeling non- 
competitive, you can settle into a Cooperative game and find out if two heads are better 

than one! 

Select the type of game you want from the Game menu. Then follow the instructions for 

your game mode below. 

In all games, if computer player is turned on, an hourglass appears while the computer is 

making its move. 

Solitaire Game 
In a solitaire game, the contestant plays alone. Here’s how to set up solitaire play: 

1 Inthe Solitaire Game dialog box, select ancient or modern scoring. 

2 For the selection of players, you have several choices: 

e Leave #1 Computer unselected to enable you to play a solitaire game. 
e Select #1 Computer to start the computer on a game of solitaire. 

3 Choose New Game to begin a solitaire game with your designated scoring and player 
choices. The board appears, set with the opening tableau of six stones. 

Selecting OK from the Solitaire Game dialog box and then New Game from the File 

menu also starts the game at the opening tableau. 

Pi aue rs: 

PIS} Lawpater 

Fig 2. Solitaire Dialog Box 
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Cooperative Game 

gyatiue Gaswe 

Plage xs! 

EP St Compater 
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Fig 3. Cooperative Game Dialog Box 

In Cooperative play, you and a partner take turns placing the stones. You can act as 
both players, play with the computer as your partner, or tell the computer to play both of 
the player roles. Whether human or computer, players earn a single, team score. Here’s 
how to set up cooperative play: : 

1 In the Cooperative Game dialog box select ancient or modern scoring. 

2 You have several choices for player selection: 

e Leave the computer options unselected to take turns placing the stones with 
another human player. 

¢ Select #1 Computer to designate the computer as a cooperative player which will 
make the first move. 

° Select #2 Computer to designate the computer as a cooperative player which will 
wait for you to make the first move. 

¢ Select both computer options to designate the computer as both cooperative 
players. 

3 Then choose New Game to begin a cooperative game with your designated scoring 
and player choices. The board appears, set with the opening tableau of six stones. 

Selecting OK from the Cooperative Game dialog box and then New Game from the File 
menu also begins the game at the Opening Tableau. 

13 
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Fig 4. Tournament Game Dialog Box 

In Tournament play, you and any number of other players take turns playing entire 
identical games, with each player receiving the same opening tableau and drawing the 
stones in the exact same order. Each player earns a separate score and the computer can 
be one of the players in the tournament series. 

As in regular play, each game in the tournament ends when the player empties the 
pouch, when the player chooses to end the game, or when the timer runs out. Here’s 
how to set up tournament play: 

1 First select New Tournament in the Tournament Game dialog box to make the other 
choices in the box available. 

In the Tournament Game dialog box, select ancient or modern scoring. This sets the 
scoring mode for all games in the tournament. 

You have two choices for player selection: 

e Leave #1 Computer unselected to take turns playing consecutive games only with 
other human players. 

e Select #1 Computer to designate the computer as the next player in the 
tournament. 

Select Time: and move the timer scroll bar to set the time limit for each game in the 
tournament. You can set the timer from one minute to 60 minutes. During the game, 
the minutes count down on screen. Or, leave Timer unselected to allow an unlimited 

amount of time for each game in the tournament. 

Then choose New Game to begin a tournament with your designated scoring, player, 
and timing choices. The board appears, set with the opening tableau of six stones. 
Selecting OK in the Tournament Game dialog box and then New Game from the 
File menu also starts the first game of the tournament at the Opening Tableau. 

After the current player ends a game, begin subsequent games in the tournament by 
selecting New Game from the File menu. You can also begin a new game by selecting 
Tournament from the Game menu and then New Game from the Tournament 
Game dialog box. 

14 
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At the start of each new game, make sure the #1 Computer box is not selected if you 
want a human to play next, and selected if you want the computer play next. 

7 Select New Tournament from the Tournament Game dialog box to begin a new 
tournament. Starting a new tournament creates a new shuffle, or order of stones in 
the pouch, and erases the current scores in Tournament High Scores. 

Challenge Game 

In challenge play, you and one other player take turns placing the stones to complete 
one game. You can also play against the computer. You can tell the computer to assume 
the role of two players competing against each other. Whether human or computer, 
each player earns a separate score within the challenge game. 

PUA? Comgater 

. os Fig 5. Challenge Game Dialog Box 

Here’s how to set up challenge play: 

1 Inthe Challenge Game dialog box, you have several choices for player selection: 

e Leave all computer player options unselected to enable you to play a challenge 
game with another human player. 

e Select only #1 Computer to designate the computer as the challenge player 
making the first move. Select only #2 Computer to designate the computer as 
the challenge player making the second move. Select both computer players to 
designate the computer as both challenge players. 

2 You can also choose to limit time for making a move to any length of time, from one 
second to 60 seconds by selecting Time and moving the timer scroll bar to set the time 
limit for each move in the challenge game. During a game, the seconds count down on 
the screen for each player. If the timer runs out before a player places a stone, that player 
scores zero for the turn and the timer begins on the other player’s turn. 



Challenge Game (continued) 
3 Then choose New Game to begin a challenge game with your designated player and 

timing choices. The board appears, set with the opening tableau of six stones. 

Selecting OK in the Challenge Game dialog box and then New Game from the File 
menu also starts the challenge game at the Opening Tableau. 

SCOREBOARD AND HIGH SCORES DISPLAY 

Scores can be represented on the scoreboard graphically with tally marks (adapted 
Roman numerals) or with standard Arabic numerals. 

Select Graphic Scoreboard from the Options menu to toggle between tally marks and 
Arabic numerals. You can also double-click on the scoreboard to toggle between the two 
representations. 

With the Graphic Scoreboard turned on, these tally marks represent the following 
numbers of points: 

High scores appear on the Today’s Scores, All-Time Highs, and Tournament High Scores 
scoreboards. Select Modern Scoring, Ancient Scoring or Tournament High Scores 
from the High Scores menu to see these scoreboards. 

Today’s Scores displays the highest scores of the day, from all game modes (except 
Tournament). Click on Clear to erase the scores. It clears automatically when the 
computer’s internal clock indicates that a new day has begun. 

All-Time Highs displays the highest scores from Solitaire, Cooperative and Challenge 
game modes. Click on Clear to erase the scores from the board. If your score qualifies, a 
dialog appears when you end the game which allows you to enter your name. 

Tournament High Scores displays the highest scores from tournament games. Starting a 
new tournament erases game scores in Tournament High Scores. 

Show High Scores After Every Game lets you see high scores whenever you end a game. 
Select Preferences, from the Options menu, then select Show high scores after every 
game to make high scores appear automatically after the end of each game. 

In Tournament play Show High Scores After Every Game — makes the Tournament 
high scores scoreboard appear. 

16 
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HELPFUL HINTS FROM YOUR 

FAVORITE GURU 

You are not alone. Several types of assistance are available to help you place stones or 
plan your strategy. To get these hints, select the Help menu and then choose: 

Undo Previous Move 

This puts the stone you just placed back on the touchstone so you can play it again. 
This is not available in Challenge play. 

Show Possible Moves 

This lets you see all legal moves for the stone currently on the touchstone. However, 
selecting Show Possible Moves when there is a move left to play disqualifies you from 
making the All-Time Highs scoreboard. 

Always Show Moves 

Selecting this command means that you will automatically see all legal moves each time 
a new stone appears on the touchstone. Turning on Always Show Moves disqualifies 
you from making the All-Time High scoreboard. A check mark appears next to this 
command when it is turned on. 

Show Pouch 

This command lets you look at the stones remaining in the pouch. Selecting Show 
Pouch disqualifies you from making the All-Time High scoreboard. 

iY, 



STRATEGY 
To become a master player, you need to learn the art of emptying the pouch while simulta- 
neously creating as many 4-Way matches as possible. Using all four corners as well as the 
center of the board increases your chance of emptying the pouch and creating 4-Ways. 

Learn how to make 4-Ways and plan ahead. You can build a strong game by anticipating 
possible moves based on the stones you know are unplayed. 

ANCIENT WAY STRATEGY 

In the Ancient Way of playing Ishidd, the main goal is to place all the stones on the 
board, thus emptying the pouch. The secondary goal is to create as many 4-Ways as 
possible, because when both players empty the pouch the player with the most 4-Ways 
wins. And if neither player empties the pouch, the player with the most 4-Ways wins. 
If neither player empties the pouch and each player has the same number of 4-Ways, the 
player with the fewest number of stones in the pouch wins. 

When playing the Ancient Way solitaire, your games will be ranked on the high scores 
display using the criteria stated above. 

MODERN WAY STRATEGY 

In the Modern Way of playing, the goal is to score the highest number of points. 4-Ways 
produce bonus points and double the point value of all subsequent moves. Thus the 
ability to create 4-Ways often and early in the game is the mark of a power player. A 
premium (and scoring bonus) is also placed on emptying the pouch of all its stones. 

CENTER MASTER PLAY 

In Center Master Play, you build upon the two center stones to create four 4-Way 
matches. 
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Here are the steps for creating a Center Master Play: 

Beginning: 
Cece eo wees e oe assess ene ne Been Dee SETHE EEE S TORE RFE EeDESE CHS BOTA SHE EE Basses eSeeAs Rens eseceesooesoNBEsoEssEEoEe 

. 

Third play 
Mocemiecancess Ge eeeesseeeeeeednetenseeenendheresereceeneeel 

—_— Two ope ni ng 
sta nes a, Ji . on an tae — 

Progressing: 

Wy 
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You have played a Master Game if you empty the pouch while creating eight 4-Way matches 

around the six opening stones (four 4-Ways around the center and one at each corner). If 

you are playing at this level, congratulations! You’re on your way to becoming a legend! 

Here is an example of a Master Game in-progress with the first six 4-Ways already played 

(indicated by arrows) and two more set-up: 

eeuensetcssseectens BEE: occsccnscnnccnsenscnsoncsconedd Va seenas esas octncencceuces Upppepepeseggarecescare 
: 

Ceeevenerrvrsesdestetsseeessesisesccneneeereen ‘ DascvescverccecsarvescucesecesUeverecseaesees stPOOO OE EEUTTTE cercccerecstsressssseesessnretinsucacssestsces sere] O : Serres 
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UsiInG On-LINE HELP 

You can get quick information about playing Ishid6 from its on-line help. To use Help, 

select Help... from the pulldown Help Menu. Scroll down the list of topics and select 

the topic you want by double-clicking on the heading, or highlighting the topic and 

select Help. 

When you select the topic you want from the Help list, information on it appears in a Help 
Information dialog box. Scroll through the text to read the information in the box. 

Fig 6. Help Menu 

e Topics returns you to the list of topics in the Help Topics dialog box. 

e Next or Previous makes the next or the previous Help Information dialog box appear. 

e Done lets you exit Help and return to the game. 

Reading about one Help topic may spark your interest in another related topic. Terms 

which are further explained in related Help topics are underlined in the Help Informa- 

tion dialog box text Click on the underlined text to go directly to the appropriate spot 
in the related Help Information dialog box. 

Looking at a related help topic makes Previous change to Go Back. Select Go Back to 

return to the help topic you were reading before you chose the related topic. 

FONT, SOUND AND MESSAGE PREFERENCES 

Ishidé lets you change the font used for menu and dialog boxes, turn sounds on or off, and 

turn messages on or off. Select the Options Menu then follow the instructions below 

when you select: 
= Ge Cane ERR 

Fig 7. Options Menu 
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Preferences ... 

This option lets you choose between The Ishidé Font or The System Font to use in 
menus and dialog boxes. 

: Fig 8. Preferences Dialog Box 

Sounds 
This option lets you turn off the special effects sounds in the game: gongs, wind chimes, 
and harp. Select Sounds again to turn the sounds back on. 

Stone click 

Select this command to turn on/off the sound of the stones being placed; a check mark 
appears next to the command when the Stone Click is on. 

Messages 

The Ishid6 Guru-in-a-Dialog-Box is ever ready to help you when you commit errors 
during gameplay. Unlike some Hints, there are no penalties for getting these messages. 
Select Messages to silence the Guru and remove the checkmark next to the menu item. 
Select Messages again to benefit from the Guru’s wisdom. Each of the stonesets provided 
with the game invokes its own individual guru. 

az 
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CUSTOMIZING ISHIDO 

CHOOSING A STONESET 

Fei Mi Jai tells us: “Many ways create the peppercorns of existence,” or, loosely trans- 
lated, “Variety is the spice of Ishiddé.” Many players switch stonesets often to make the 
look of the game suit their mood. You are provided a large variety of stonesets in both 
the black & white and color versions of Ishidé. Follow these steps to view and choose an 
Ishid6é stoneset: 

For Black & White Versions 

1 Select Stoneset... from the Options menu. The Choose a Stoneset dialog box 
displays a graphic sample of six stones from the current stoneset. 

C3 Genesis 
3 loear Shapes 

- { Cancel } 

Fig 9. Choose a Stoneset Screen 

2 Click on the button of one of the other named Ishidé stonesets to see a sample of its 
stones. Select View or double click on a stone icon to see the rest of the stoneset (36 
of the 72 stones). Select Done to close the View Stoneset dialog box and return to 
the Choose a Stoneset dialog box. 

3 Click on OK to close the Choose a Stoneset dialog box and return to Ishid6. Your 
stoneset of choice appears on the board if you have a game in progress. 

Select Cancel to close the Choose a Stoneset dialog box without selecting another 
stoneset. 



For Color Versions 

1 Select Stoneset... from the Options menu. The Choose a Stoneset dialog box displays 
a graphic sample of six stones from the current stoneset. 

Fig 10. Choose A Stoneset Dialog Box (color) 

2 Click on the scroll bar arrows to view one of the other Ishidé stonesets. Double click 
on any of the stones, or select Edit to view all the 36 unique stones in the stoneset. 
Select OK to close the Edit Stoneset dialog box and return to the Choose A Stoneset 
dialog box. 

3 With your selected stoneset showing in the box, click on OK to close the Choose A 
Stoneset dialog box and return to Ishidé. Your stoneset of choice appears on the board 
if you have a game in progress. Select Cancel to close the Choose A Stoneset dialog 
box without selecting another stoneset. 

CHOOSING A BACKGROUND 

You can choose between dozens of Ishidé backgrounds to use behind the game board in 
both black & white and color versions. 
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Black & White Version 

1 Select Background... from the Options menu. The Choose a Board dialog box 
displays the background currently in use. 

2 Click on the name or button for one of the other backgrounds to see it in the pattern 
view box. 

You can also click on Standard Patterns or Special Patterns and move the scroll bar to 
~ see a sample of additional backgrounds. 

Fig 11. Choose A Board Background Screen 

3 With your aceRRA selected, click on OK to close the Choose A Board dialog box 
and return to Ishidd. Your pattern appears as a background behind the board. Select 
Cancel to close the Choose A Board dialog box without placing another background 
pattern behind the board. 

Color Version: 

1 Select Background... from the Options menu. The Choose A Background dialog 
box displays the background currently in use. 

2 Inthe color version you can choose either Picture backgrounds or Color back- 
grounds. Picture backgrounds use objects of any size and then repetitively piece them 
together to form the entire full screen background. Color backgrounds utilize a color 
wheel and enable you to choose any of thousands of different colors to use as your 
background. 

Click on the scroll bar arrows to move through the selection of backgrounds. Click 
on either the Color or Picture buttons to move between the two types. 

3 With your selected background showing in the box, click on OK to close the Choose 
A Background dialog box and return to Ishid6. Your pattern appears as a background 
behind the board. Select Cancel to close the Choose A Board dialog box without 
placing another background pattern behind the board. 
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CHOOSING A BOARD 
(available in color version only) 

In color versions you have the option to choose from a variety of boards to go with your 
stonesets and backgrounds. 

Fig 12. Choose a Board Dialog Box 

1 Select Board... from the Options menu. The Choose a Board dialog box displays a 
eraphic sample of the board currently in use. 

2 Click on the scroll bar arrows to view one of the other Ishid6é boards. Slag OK to 
close the Choose a Board dialog box and return to the game. Select Cancel to close 
the Choose a Board dialog box without selecting another board. 
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THE ART OF STONES 
As the “Legend of Stones” relates, Ishidé has always been much more than a game. The 
following sections will provide you entré into the world of the Art of Stones, wherein 
you customize and create your own stonesets, backgrounds, and (in the color version) 
playing boards. If you have a sense of adventure and/or a creative bent, you’ll find these 
graphics editors surprisingly powerful. 

Experiment. This aspect of the game can be very satisfying and will provide hours of 
entertainment in a form you probably didn’t expect when you acquired your edition of 
Ishid6. These instructions are the tip of the iceberg. Before long you could be creating 
Ishid6 graphics using methods that we hadn’t even envisioned. 

And remember, with Ishid6 there is one Way ... but many paths. 

CREATING AND EDITING STONESETS 
If you get tired of using the ready-made Ishid6é stonesets or simply desire a more personal- 
ized set, just create your own. With its sophisticated graphics editors, Ishidé lets you 
create entirely original stonesets or copy and edit those that came with the program. 

What is a Stoneset? 

An Ishidé stoneset must have six different symbols and six different patterns or colors. 
One symbol repeats across each of the six rows in the stoneset. One pattern/color 
repeats down one of the six columns in the stoneset. Applying the six colors or patterns 
to six symbols creates 36 unique stones. These 36 stones are one set in the pair that 
makes up a stoneset of 72 stones. 
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Black & White Version 

Let’s start from scratch to make an original stoneset. Follow these steps: 

1 Select Stoneset... from the Options menu. The Choose a Stoneset dialog box appears. 

2 Select Other to make the scroll bar appear. Scroll to the far left to select the blank 

stoneset. 
SB tile Sawer Optimns 

es wat Fig 13. Choose a Stoneset Screen 

3 Select New. The New Stoneset dialog box appears. 

onesies pscdenananny grannnncnnny puneanoniny gttiensti 

Hew Glaneset 

Fig 14. New Stoneset Screen 

4 Click once on the stone at the upper left (first row and first column). Double click on 

the stone or click on Edit to see the Stone Editor. 

exc _ of are Opheos Helo fph Scores oa 

Design Tools 

Actual Size Box 

Design Tools 

| Rattera— 

Zoom View Box 
® Staodasd [2 

—— Expand/Compress Tool 

Fig 15. Stone Editor Screen 
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Zoom View Box - Create your stone drawing here. 

Actual Size View Box - Shows the actual size of your design as you draw. 

Pattern View Box - Shows current Standard or Special fill pattern used by the paint 
bucket. Select Standard or Special and scroll to select the pattern you want. 

Design Tools - Select these to create your drawing. See the Design Tools section for a 
description of how each tool works. 

5 You are now viewing an actual stone. However, the face of the stone is blank. You 
may re-shape the stone by selecting any design tool and place the tool over the stone 
in the zoom box to edit. Please see the Design Tools section for information on 
using each tool. 

When you’re satisfied with your new shape, select OK to save the shape and return to 
New Stoneset. 

Select the next stone down in the first column. Double click on it or select Edit to 
open the Stone Editor again and follow steps 5 and 6 above to draw a different shape. 
Continue down the column drawing shapes on the first stones in the 3rd, 4th, 5th 
and 6th rows. 

Click on the white space outside the stones so that one particular stone isn’t selected. 
Select Copy to Row. Each shape is duplicated across its row, filling the stoneset. 

Selecting an individual stone and then selecting Copy to Row copies only the shape 
of that stone to all the other stones in that specific row. 

Once again, click on white space outside the stones. Then select Make Mask. The 
stones in the 7th column will now take on the new stone shapes. 

10 To draw a design on a stone, select any design tool and place the tool over the stone 
in the zoom view box to work on your drawing. Please see the Design Tools section 
for information on using each tool. 
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What is a Stoneset? (continued) 

11 When you’re satisfied with your drawing, select OK to save the drawing to the 
selected stone and return to New Stoneset. 

Selecting Cancel returns you to the New Stoneset dialog box without saving your 
drawing. 

12 Select the next stone down in the first column. Double click on it or select Edit to 
open the Stone Editor again and follow steps five and six above to draw a different 
design. Continue down the column, drawing designs on the first stones in the third, 
fourth, fifth and sixth rows. 

13 Click on white space outside the stones so that no one particular stone is selected. 
Select Copy to Row. Each Symbol is duplicated across its row, filling the stoneset. 

Selecting an individual stone and then selecting Copy to Row copies only the 
drawing on that stone to all the other stones in that specific row. 

14 Instead of drawing from scratch, the Fill Column ... command is an expedient way 
to place patterns on your stones. Click on any stone, then select Fill Column.... 
The first column background always stay white and cannot be filled. The Choose A 
Pattern dialog box appears. Select the pattern you want by clicking on named 
patterns or scrolling through the list of Standard or Special patterns. The pattern 
you select appears in the pattern view box. (An alternative method is to fill your 
individual stones using the paint bucket from the Edit Stone screen.) 

15 When you see the pattern you want in the pattern view box, select OK. The 
Choose A Pattern dialog box closes and the pattern appears over all the stones in the 
column. 

16 Repeat steps 14 and 15 above to fill in background patterns for the stones in the 
remaining columns. 

17 When you have finished your stoneset, select OK in the New Stoneset dialog box to 
save the stoneset to the Other menu. The Choose a Stoneset dialog box appears with 
a sample of your new stoneset. 
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Selecting Save saves the stoneset without exiting the New Stoneset dialog box. 

Selecting Save and then Cancel saves the stoneset and returns you to the Choose a 
Stoneset dialog box. | 

Editing Your Stoneset 

Design Tools 

Actual Size Box 

Design Tools 

Zoom View Box 

Expand/Compress Tool 

Fig 16. Edit Stoneset Screen 

After you have created a stoneset, you may want to go back and make changes to it. 
Follow these steps to edit your stoneset: 

1 Select your stoneset from Other, then select Edit in the Choose a Stoneset dialog box. 

Selecting Edit lets you make changes to the stoneset and replace the old version with 
the changed version. 

Selecting New lets you make changes to the stoneset and save the new version as an 
additional stoneset, keeping the old version intact. 

Select the stone you want to edit and choose Edit to open the Stone Editor. 

Use the Design Tools to make changes to your drawings and background patterns. 

When you are satisfied with your changes, select OK in the New Stoneset dialog box 
to save the edited stoneset to the Other menu. The Choose a Stoneset dialog box 
appears with a sample of your new stoneset. 

Selecting Save saves the stoneset without exiting the Choose a Stoneset dialog box. 

Selecting Save and then Cancel saves the stoneset and returns you to the Choose a 
Stoneset dialog box without selecting your stoneset from the Other menu. 
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Copying a Ready-Made Ishid6é Stoneset 

Instead of creating a stoneset from scratch, you may want to modify one of the stonesets 
that come with Ishidd. Since these stonesets are locked and can’t be directly modified, to 
do this you must copy and paste the Ishidé stoneset you want to the Other menu and 
then edit the copy of the stoneset. 

Follow these steps: 

1 Inthe Choose a Stoneset dialog box, select the named Ishidé stoneset you want to copy. 

2 Select View. 

3 Inthe View Stoneset dialog box, select Copy then select Done. The Choose a 
Stoneset dialog box reappears. 

Select Other and scroll left to the empty stoneset. 

Select New. The New Stoneset dialog box appears with the blank stoneset. 

Select Paste. The stoneset you selected appears pasted over the blank stoneset. 

ND MN BB Select OK to save your stoneset to the Other menu. Now you're ready to edit your 
copy of the original stoneset. 

Creating a Stoneset Template 

In a burst of creative enthusiasm, you may accidentally save one of your stoneset designs 
over the stoneset template. This happens when you scroll to the blank stoneset template 
in the Other menu and then select Edit instead of New to draw a design, then save the 
stoneset over the template. 

Follow these steps to restore the stoneset template: 

1 Inthe Choose a Stoneset dialog box, scroll to any stoneset in the Other menu. 

2 Select New. The New Stoneset dialog box appears, showing the selected stoneset. 

3 Select Clear. The stoneset disappears. 

4 Click on the spot where the stone in the first column and row usually appears. The 
selection box appears. 

Wn Now select Edit to make the Stone Editor appear. 

6 Inthe Stone Editor, select the rectangle tool and place the crosshair cursor at the 
top left pixel of the zoom view box (illustration A). Click and drag the crosshair 
until it makes a border in the zoom box (illustration B). 

A. B. =i 
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Select the pencil tool. Click on the top right and lower left pixel of the border to 
erase them. 

Select the line tool. Draw a line along the right and lower edges of the border. 

Select OK. Your empty stone appears at the top left of the Edit Stoneset dialog box. 
With the stone still selected, select Copy. Select the spot beneath the stone, then 
select Paste. Select and paste four more times, creating stones all the way down the 
first column. 

Click to the left of the first column of stones, outside the stones, then select Copy to 

Row. Your blank stones appear across each row. 

aS Ea: a ae 
Click on white space outside to the left of the stones (under Revert), then select 
Make Mask. The area in the stone appears as a solid block, or mask. The mask 
enables the stone to appear opaque against the board and touchstone. Create the 
mask before you fill with background patterns. 

Select OK to save the stoneset template to the Other menu and return to the 
Choose a Stoneset dialog box. 
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Creating a Partially Transparent Stoneset 

Although the stoneset template is a useful tool for creating stonesets, you don’t have to 
stick to solid, rectangular shapes for the stonesets you create. Of the stonesets that come 
with Ishidd, Genesis, Runes, Magica, and Ramses have shaped stones. The Genesis 
stoneset even has holes in several of its stones. 

To modify the shape of a stone and create “holes,” or transparent places in it, you need to 
modify the mask, or opaque layer beneath the stone. Follow these steps to reshape the 
mask as you create a new stoneset: 

1 Using the stoneset editor of New Stoneset, “chisel” away at the stone border by 
redrawing it. Create the symbol on the stone, copy it across the row. Complete the 
symbols for the other stones in the stoneset. 

2 When you make the mask for each row, the mask takes the same shape as the 
“chiselled” stones in the row. 

3 To put a “hole” in a stone, select the mask for the row with the hole in the design. 
Use the eraser or pencil to erase the portion of the stone which corresponds to the 
hole in the stone. 

4 Save the stoneset. When you play a game with the stoneset, notice that the 
“chiselled” portions of the stone or holes are transparent against the touchstone and 
the board. 

5 Feel free to experiment with your masks. Try gray or patterned masks instead of black 
ones...for semi-transparent stones. And remember, the masks can be edited exactly as 
the stones are edited when you double click on them. You can create some very 
mysterious effects by altering the masks. 

Using Other Paint Programs to Design Stonesets 

You can use other paint programs to create and enhance your stonesets. Follow these 
steps: 

1 Select the stoneset you want to enhance and copy it. Copy one of the templates if 
you want to create your stoneset from scratch using your paint program. 

2 Under the desk accessory [ (3 ] menu, open the scrapbook. Paste the stoneset into 
the scrapbook. (Or, if you are using Multifinder, paste it directly into your paint 
program. ) 

3 Close the scrapbook, quit Ishidé and open your paint program. 

4 Open the scrapbook (see note above) and paste the stoneset into your paint program. 
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When you finish enhancing the stoneset, copy it back into the scrapbook (or go 
directly to the next step if you are using Multifinder). Close your paint program and 
open Ishido. 

Select a stoneset in the Other file and select New in the Choose a Stoneset dialog 
box, then Clear the stoneset. 

Select Paste to paste the enhanced stoneset over the cleared . 

CREATING A STONESET FOR THE 

COLOR VERSION 

Creating and editing stonesets in the color version is very similiar to the method used in 
the black and white version. However, there are some differences: 

1 

Z 

The most obvious difference, of course, is you are now working in color rather than in 
black and white. 

You have one additional tool: the eye dropper. Choose the eye dropper, point with 
its tip to a color which you wish to work in—either from the palette of available 
colors to the right of the dialog box or from the drawing of the stone itself—and click 
the mouse button. Now your-pencil, paint bucket, line draws, etc. will be all drawn 
in that color. You can conveniently access the eye dropper any time when using 
another design tool by toggling with the Control key. Colors can also be selected 
with the arrow cursor by clicking on the color of your choice in the color palette. 

fit Share 

Fig 17. Stone Editor 

There is no need to create masks in the color version. All colors except transparent 

white are opaque. 

Empty stoneset templates are not provided with the color version, so you'll either 
have to choose an existing stoneset to use as a template or make one yourself. You 
choose an existing stoneset to use as a template by scrolling to the stoneset you'd like 

to begin with, then selecting New. 
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CREATING A STONESET FOR THE 

COLOR VERSION (CONTINUED) 

Fig 18. New Stoneset Screen 

5 You can give your new stonesets names in the color version, or change the name of 
existing stonesets. 

Creating Color Stonesets With Your Own Paint Program 
There are many effects and tools which most color paint programs have which make 
creating stonesets a delightful experience. Follow these directions to create stonesets 
using your own color paint program. 

1 Select Stoneset... from the Options menu. The Choose a Stoneset dialog box 
appears. Scroll to the stoneset you would like to use as a template. 

2 Select Copy. Select Cancel. Quit Ishid6, open your paint program, select Paste 
under the Edit menu (if you are using Multifinder, paste directly into your color paint 
program). At this point you are free to create, change, play and add color within 
these limitations: 

e Do not alter the format; use the stoneset you’ve copied as your template. This is to 
ensure that when you copy the stoneset and place it back into the game it fits 
properly. 

e Your color palette is limited to 150 colors (the remaining color slots are reserved 
for the board and backgrounds). Optimize you color palette before importing your 
stoneset back into Ishidé by customizing your palette and clearing all colors except 
those used within the stoneset. This will minimize the likelihood of experiencing 
incomplete or altered color palettes when playing the game. 

36 



the Wary of Soned 

3 When your stoneset is complete and you are ready to paste back into Ishid6, copy it 
and paste it into your scrapbook, or return to the game using Multifinder. Once back 
in the game select Stoneset... from the Options menu. The Choose a Stoneset 
dialog box appears. 

4 Move the scroll bar to the stoneset after which you want your new stoneset to be 
placed and select Paste. Voila! Your new stoneset is now in the game and ready to 
be played. 

5 Select Name Stoneset... to enter a name for your stoneset. 

6 After playing with your new stoneset, you might wish to touch it up a bit. Select Edit 
to touch it up within the program. Notice that the new color palette now is the one you 
imported into the game with your new stoneset. 

CREATING AND EDITING BACKGROUNDS & 

PATTERNS 

In addition to designing stonesets, Ishidé lets you create and edit your own original 
patterns and colors to use for game board backgrounds, stoneset backgrounds, and paint 
bucket fills. | 

Black & White Version 

1 Select Background from the Options menu. 

2 Click on Standard Patterns or Special Patterns. Move the scroll bar until you see 
the background you want to modify. 

Fig 19. Background Editor 

3 Select New or Edit to open the Pattern Editor. 

Select New if you want to create and add an additional background in the Standard 
Patterns or Special Patterns menus. 

Select Edit if you want to change and replace a current background. 
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You can also edit a pattern while in the process of creating or modifying a stoneset, by 
opening the Pattern Editor when using Fill column... or filling in stone backgrounds 
with the paint bucket. 

Fig 20. Pattern Editor 

Zoom View Box - Create your pattern here. 

Actual Size View Box - Shows the actual size of your design as you draw. 

Design Tools - Pointing to tools at right and left of box. Use these tools to work on your 
pattern. For further explanation see pages 41 and 42. 

Fig 21. Special Pattern Editor 

Zoom View Box - Create your pattern here. 

Expand/Compress Tool - Use this design tool to modify the size of your pattern. 

Actual Size View Box - Shows the actual size of your design as you draw. 

Design Tools - Pointing to tools at right and left of box. Use these tools to work on your 
pattern. For further explanation see pages 41 and 42. 

4 Use the design tools to create the pattern you want in the zoom view box. 
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5 Select OK to save your background design and return to the Choose a Board dialog 
box. 

If you are working in New Pattern, selecting OK closes the Pattern Editor, saves your 
new pattern as an additional pattern in the Other menu, and returns you to the 
Choose a Board dialog box. 

If you are working in Edit Pattern, selecting OK closes the Pattern Editor, saves your 
new pattern over the old pattern, and returns you to the Choose a Board dialog box. 

Selecting Cancel in the Pattern Editor returns you to the Choose a Board dialog box 
without saving your work. 

6 Selecting Cancel in the Choose a Board dialog box returns you to Ishidé without 
placing the new background pattern behind the board. Access your new background 
by scrolling through the Other menu. 

Selecting OK in the Choose a Board dialog box returns you to Ishidé and places your new 
pattern as a background behind the board. 

Selecting Delete in the Choose a Board dialog box permanently erases the current 
background in the pattern view box. 

Color Version: 

The color version of Ishidé allows you to use either pictures or solid color fills as 
backgrounds behind the playing board. 

Pictures ae 

Pictures are created with a paint program and then imported into the game. The 
possibilities are almost infinite. Just remember that Ishidé’s graphics editor uses the 
picture, whatever its size, to fill up the entire screen. So that, for instance, if you 
imported just one black pixel, that picture would be repeated and juxtaposed such that 
the entire background would appear black. Here’s how some of the backgrounds you 
received with the game were created: 

1 All gradient backgrounds (the ones that go from dark to light, or form rainbow-like 
patterns) use a single picture about 15 pixels wide and 400 pixels high (the exact full 
height of the screen). Simply choose the colors of the gradient and use a gradient fill 
function with the rectangle tool to create a tall, thin strip of color. 

2 Then copy this using the shrink/transparent tool (or any method that does not 
include a black or white outline), paste to your scrapbook (or move directly to the 
game using Multifinder) and open Ishid6, select Backgrounds... from the Options 
menu, select the Picture button, and Paste. 
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Ishid6é allows you to choose from 1 million+ colors to use as your background. Select 
Backgrounds... from the Options menu, select the Color button, then select Choose 
Color.... This will take you to the Choose a New Color: Color Wheel — which is 
Apple’s standard color selector. 

The Color Wheel allows you to modify six variables — Hue, Saturation and Brightness, 
and levels of Red, Green and Blue — to create virtually any color your heart desires. You 
can do this scientifically by changing the numerical values and moving the scroll bar; or 
intuitively by moving the cursor over the circle and clicking. 

Experiment with this tool. It’s very easy and lots of fun to use. 

CREATING NEw PLAYING BOARDS 

(Available in color version only) 

Ishidé allows you to create new boards in your color paint program and import them into 
the game. Follow these steps: 

1 Select Board... from the Options menu. This brings you to the Choose a Board 
dialog box. Select a board to use as a template then select To disk.... Name it and 
save it. 

2 Open the file you just saved from within your color paint program. You are now ready 
to create your own board. Remember that the template is used to guide placement of 
the board’s outer dimensions, the placement of the squares on the board, and how you 
situate the touchstone, scoreboard and pouch. 

Every element of the board as mentioned above is customizable. You sche want to 
experiment with transparent and semi-transparent boards (using transparent white), 
and even go beyond the parameters and dimensions of your template. 

3 When you are satisfied with your creation save the file. Then reenter Ishidé, select 
Board... from the Options menu, and select From Disk.... Find the file you just saved 
with your customized board in it and Open it. Ishidé automatically imports the board into 
the game. Choose OK and the game is now ready to be played using your board. 
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DESIGN TOOLS 

Here are the design tools available in Ishidd’s graphic editor: 



si) 
DESIGN TOOLS (CONTINUED) 

Clicking on these tools has the following effect on your graphic: 

Tool Use and Function 
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MOVING STONESETS, BACKGROUNDS AND BOARDS 

After you create your own stonesets and backgrounds, you can save them to diskette and 

move them between computers or swap them with friends. We use the black & white 

version exclusively in the following tutorial. However, the instructions are essentially 

the same for color as for black & white. The only differences being that with color you 

move picture backgrounds instead of standard and special patterns, and you can also 

move playing boards. 

Follow these steps to move Ishid6 graphics from your hard disk or Ishid6 diskette to a 

friend’s diskette or from a friend’s diskette back to your hard disk or Ishid6 diskette. 

Please refer to your Macintosh user manual if you need additional information on the 

hierarchical file system. 

1 Select Stoneset... or Background... from the Options menu and choose Mover... from 

the Choose a Stoneset or Choose a Board dialog box. The Mover dialog box appears. 

2 Select either Stoneset, Standard Pattern, or Special Pattern, (or in the color version: 

Stoneset, Background, Board) depending on what type of file you want to copy. 

selexivd: 

Fig 22. Stoneset Mover Screen 

3 Select the Open... button beneath one of the scroll boxes to see lists of files and 

folders and find Stoneset, Standard Pattern, and Special Pattern files on the current 

disk or in the current folder. If you don’t see Open... below a Mover scroll box, first 

click Close to close the currently displayed file. 

Select and open (or double click on) any folder to see the files or other folders in it 

(moving away from the disk directory). Press on and drag the directory title to see what 

other files or folders are on the disk directory (moving toward the disk directory). 

To look for stoneset or background files on other disks, insert the disk in the drive. Use 

the Drive button or use the Drive and Eject buttons to look for stoneset or background 

files on other disks or on your disk drive. The name of the disk you’re looking at appears 

at the top of its corresponding list dialog box, soon after you insert the disk. 
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Open the file you want to look at by selecting its name and then clicking Open..., or 
by double-clicking its name. If it contains the type of file you specified (Stoneset, 
Standard, or Special Pattern), one of the patterns or stonesets appears in the Mover 
scroll box. If the file or folder you chose does not contain the type of pattern — 
Stoneset, Standard Pattern, or Special Pattern — you indicated above, then the 

Mover scroll box will appear empty. 

You can look at and work with any existing stoneset or pattern file. Both the name of 
the file you have open and the name of the disk or drive it’s on appear below the 
appropriate Mover scroll box. 

Once you open a file, you can use the scroll bar to look at all the stonesets or patterns 
in the file. 

The line near the top arrow of the scroll bar indicates the number of stonesets or 
patterns in the current file and the number of the current graphic. In the previous 
figure, the file contains seven stonesets. A sample of the third stoneset in the file 
appears in the Mover scroll box. 

You can create a new file for storing your own collection of stonesets, patterns, 
backgrounds and/or boards by inserting a blank, formatted disk into your disk drive 
and clicking New..., typing in a name for the file at New Stoneset/Pattern file, and 
selecting Save. Then select and open the file containing the stonesets or patterns 
you want to copy to or from, just as you did in steps 3, 4, and 5 above. 

Click on one of the Mover scroll boxes to select the stoneset or background pattern 
you want to copy. This is the active Mover box. You can select from the box on the 
right or on the left. The arrows around Copy point toward your stoneset or pattern’s 
destination. 

Click Copy to copy the stoneset or pattern displayed in the Mover scroll box to the 
destination diskette. A sample of the stoneset copy appears in the destination Mover 
scroll box. The number of stonesets or patterns in the destination file increases by one. 

Copy All copies all the stonesets, patterns, backgrounds or boards from the file 
displayed in the active Mover box to the destination file. 

Remove erases the stoneset, pattern, background or board displayed in the active 
Mover box. 

Remove All erases all the stonesets, patterns, backgrounds or boards from the file 
displayed in the active Mover box. 

44 



the Way, of Stored 

SPECIFYING FORMAT FOR YOUR 

GRAPHICS FILES 

Save Screen to Disk... from the File menu saves a screen of the game board during play 
as a paint file on your hard disk or diskette. Select the folder you want to contain the 
file. Then type in the name of the file at Save Screen As: and select Save. 

Ishidé’s Document Editor feature lets you save a screen in the application format you 
specify. Specifying the application you want lets you open the graphics file and the 
application at the same time. If you don’t specify a format, you must first open your 
MacPaint compatible graphics processing application, and then use it to open the 
graphics file. 

Follow these steps to select the graphics processing application on your system: 

1 Select Preferences. At Document Editor, select Paint Files (or Pict Files in the 

color version) by clicking once inside the rectangular box. A scrollable list box 
appears, showing the current file or folder. 

% Stier eaery Qoore : 

Eau aad deaoy SEXES witby 

@ fhe ishids foot : 
Co The System font 

Fig 23. Preferences Dialog Box 

2 Locate and select the graphics application you want to use and select Open. The 
Document Editor dialog box appears with the name of your graphics application after 
Paint Files (or Pict Files in the color version). 

3 Select OK to close the Preferences dialog box and return to Ishidd. Select Cancel to 
close the dialog box without saving your graphics format choice. 
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THE ORACLE OF THE STONES 

The Oracle of the Stones is a system of divination based on the principle of 
synchronicity*—the theory that the coincidence of events in space and time involves 
something more than mere chance. What we take as coincidence—for example, the 
arrangement of the stones in the 4-Way pattern from their random order in the pouch — 
depends not only on the physical reality of the stones available to be played, but on the 
state of mind of the player as he or she chooses where to place each stone. 

The Oracle of the Stones uses this “meaningful coincidence”—the arrangement of stones 
in the 4-Way — as a tool for gaining insight into a situation or question posed by the 
player. Frequently mistaken as mere fortune-telling, the Oracle of the Stones allows the 
user to examine the full potential of a given situation, as mirrored by the 4-Way. 

The Oracle readings, or auguries, produced by the 4-Ways reflect the questioner’s state of 
mind at the moment the 4-Way pattern comes into existence. Brief and at times cryptic, 
the resulting auguries challenge the questioner to divine, or figure out by intuition, the 
response to the problem or question he or she brought to the Oracle’s attention. Most of 
the time, this simple act of divination can allow the questioner to discover a fresh 
perspective on the problem—and, perhaps, to uncover a solution. 

*The term “synchronicity” was coined by Swiss psychologist C. G. Jung. For an excellent discussion of this 
concept, please refer to “Synchronicity: An Acausal Connecting Principle,” The Structure and Dynamics of the 

Psyche (Collected Works of C.G. Jung, volume 8). 
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TRADITIONAL ORACLES AND 

COMPUTER ORACLES 

Since the earliest civilizations, consulting an oracle has required the discipline to learn 
the appropriate — and frequently intricate — divination techniques, and the patience to 
execute them conscientiously. These techniques were purposely designed to create an 
optimal time and space for the questioner and oracle to merge and become as one. It 
takes time, planning, concentration and even meditation to produce a 4-Way, and that is 
the Ishidéd technique for consulting the Oracle of the Stones. 

Webster defines oracle as “a shrine through which hidden knowledge is revealed.” The 
computer is certainly a most appropriate oracle for our new age. Perhaps the most powerful 
tool any of us has ever possessed, our computers do, frequently, reveal hidden knowledge. 
Some of us become so engrossed in their power and complexities that we really do relate to 
our Macs as shrines! What would tickle an ancient sage more than utilizing this very 
epitome of logic to produce a result which totally defies logical explanation? 

Ls eet EO Rae EO FT E...S-1-0 NES 

So how do you use Ishid6’s computerized Oracle? There are four steps: figuring out the 
question you want to ask, asking it, creating a 4-Way match, and then interpreting the 
augury that results from the 4-Way. 

First, Formulate the Question 

Questions that can be answered with a simple “yes” or “no” don’t usually work well, 
because they can’t tap the richness of the Oracle’s response. Instead, try questions like: 
“What will be the outcome if...?” or “What effect will such an such an action have on...?” 
or “What do I need to know about...?”” This kind of thoughtful questioning encourages a 
more lucid state of mind and allows the Oracle’s response to be both appropriate and 
comprehensible. 

Another technique is to make one to three queries around a specific subject. The 
questioning could go something like this: 

e “Please describe my present situation in regard to...” 

e “What is the best path to follow in this situation?” 

e “What else do I need to know?” 

Experience shows that asking too many questions on a subject frequently muddies the 
water more than clears it. Better to ask just one question that is absolutely clear in your 
mind, than several that are vague. 

Next, Ask the Question 

Now that you have your question, begin a game and then follow these steps: 
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Next, Ask the Question (continued) 

1 Select Oracle under the Options menu to engage the Oracle. If you do this during a 
game, the “What is your question for the Oracle?” dialog will appear immediately. If 
you do this prior to beginning, the dialog will appear as soon as you begin a New 
Game. 

At the dialog box, type in your question for the Oracle. Use the delete key, double 
click on a word, or highlight several words (as you would with any standard word 
processor) if you need to edit your question. If you want to think some more about 
your question, select Cancel to close the dialog box without saving the question. 

Fig 24. Oracle Dialog Box 

When you are satisfied with your question, select OK to save your question and close 
the dialog box. If you wish to change your question after selecting OK, you must 
reselect Oracle under Options twice (the first time will deselect the Oracle, the 
second time will reselect it). Your question will reappear and you may change it as 
you please. 

When you create a 4-Way, an Oracle Augury appears in response to your question. 

Fig 25. Oracle Augury 

Read = text, ca ae the Gane Auegury dialog box and resume playing. Follow steps 1 
through 3 above to create another question any time before you complete your next 4-Way. 

A 4-Way produces one Oracle reading only. You cannot undo your last move after 
achieving a 4-Way and obtaining an Oracle reading. The Oracle is not available in the 
computer play mode. 
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If you complete a game without having achieved a 4-Way and thus haven’t received an 
Oracle answer to your question, the “What is your question?” dialog will automatically 
reappear with your unanswered question when you begin a new game. Simply select OK 
if you still wish a response to that question. 

Then, Interpret the Augury 

When you create a 4-Way, the Oracle augury, or reading, appears. Move the grabber 
hand or use the scroll bar to see all the text. 

An augury is a sign, or indication; a way of discerning a course of action (or inaction) by 
observing and interpreting. Ishidé auguries are based on an ancient oracle known as the I 
Ching, the Chinese Book of Changes. Ishid6 arrives at a particular augury by factoring the 
identities and locations of the five stones in the 4-Way with the precise time at the 
moment the move is made. 

To understand the meaning of the augury, think of its language in terms of symbol and 
metaphor. Any answer which responds literally to a question is not so rare as it is 
fortuitous. Expect to have to intuit the message conveyed by the augury. 

Sometimes answers respond not to the question that was asked, but to the hidden 
question that may be confronting the questioner’s subconscious. If you are attuned to 
this possibility, you can use your intuition to interpret a meaningful response. 

Whether the auguries seem clear or confusing to you, keep in mind that the Oracle of the 
Stones is not a fortune-telling device. It does not absolve the questioner of the responsi- 
bility for making choices about the future. It does not determine the future. What the 
Oracle of the Stones can do is direct attention toward those inner choices that remain 
“hidden” until the proper question is asked, and so aid the questioner in making decisions 
that are pivotal in determining the future. 

Saving Auguries 

You can save an individual Oracle Augury when you read it, or set up an option that 
automatically saves all Oracle readings. 

To save an individual Oracle reading, follow these steps: 

1 With the Oracle reading dialog box still open, move the cursor to the top of the 
screen, and select Save Stonecast... from the Options menu. 

2 Inthe Save Oracle text in: dialog box, select the Default file to save the Oracle 
reading to. You can rename this file, and/or create new ones as you desire. 

Select Open File... to save the Oracle reading to an existing file. A dialog box appears, 
with a scrollable list of files. Select the file or folder you want to contain the Oracle 
reading and then select Open. Select New File to save the Oracle reading to a new file. 
Type in the name of the new file at Create an Oracle save file: and select Save. Select 
Cancel to close any of the dialog boxes without making a selection. 
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Saving Auguries (continued) 
To automatically save all Oracle readings, follow these steps: 

1 Select Oracle Preferences, under Options. 

Citidomehecallg saoe fhe stasecast fo o text file 

nryeot fader Cater Hoos asto 

[Gero Fide. | 

Fig 26. Oracle Preferences Dialog Box 

2 Inthe Oracle Preferences dialog box, select Automatically save the stonecast to a 
text file. Ishidé automatically saves all Oracle readings to the current file. 

Select Open File to save the Oracle reading to an existing file. A dialog box appears, 
with a scrollable list of files. Find and select the file or folder you want to contain the 
Oracle reading and then select Open. Select Cancel to go back to the Oracle Prefer- 
ences dialog box without choosing a file. 

Select New File in the Oracle Preferences dialog box to save the Oracle reading to a 
new file. Type in the name of the new file at Create an Oracle save file: and select 
Save. Select Cancel to go back to the Oracle Preferences dialog box without setting up 
a new file. 

Ishid6’s Document Editor feature lets you save Oracle augury files in the application 
format you specify. Specifying the application you want lets you open the augury text 
file and the application at the same time. If you don’t specify a format, Ishid6 saves 
augury files as unformatted text files that can be opened from within any MacWrite 
compatible word processor. Follow these steps to select the word processing application 
on your system: 

1 Select Preferences (not Oracle Preferences). At Document Editor select Text Files 

by clicking within the rectangular box. A scrollable list box appears, showing the 
current file or folder. 

2 Locate and select the word processing application you use and select Open. The 
Document Editor dialog box appears with the name of your word processing applica- 
tion after Text Files. 

3 Select OK to close the Preferences dialog box and return to Ishidd. Select Cancel to 
close the dialog box without saving your text format choice. 
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Specifying Gender 
The Oracle can respond to your questions using either male or female pronouns. Indicate 
your preference by choosing it from the Oracle Preferences section under the Options 
menu. 

THE HEXAGRAMS 

The Oracle of the Stones uses the same synchronistic context and mathematical prob- 
abilities to produce an augury as does the I Ching. Each Ishidé augury corresponds directly 
to an I Ching hexagram. , 

Follow these steps to see the I Ching hexagram resulting from your 4-Way. 

1 Select Oracle Preferences, under Options. 

2 Select Show an I Ching hexagram with the stonecast and then select OK. The 
I Ching hexagram corresponding to your stonecast appears when you receive an 
Oracle reading. 

3 Select the option to show an I Ching hexagram with the stonecast again and then 
select OK to make the hexagram disappear. Select Cancel to close the Oracle 
Preferences dialog box without saving your Oracle Preferences choice. You can make 
this selection before the augury appears or while you are reading the augury. 

For a fascinating explanation of how the I Ching works, how hexagrams are formed, and an 
introduction to the concept of synchronicity, please refer to C.G. Jung’s foreword and Richard 
Wilhelm’s introduction to and interpretation of The I Ching, or Book of Changes (Princeton, NJ: 
Bollingen Series XIX, Princeton University Press, 1967). 
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ABOUT THE STONESETS 

labudo 

(Bw, Color} 

= THE RISING SUN 

Tt = TORI 
(Shinto, purhcaton) 

ie = THE ENDLESS KNOT 
(Nade-Takara-Nusubh 

a = BUDDHA 

=I = SHOU ¢Long Life) 

gy = ¥IN/YANG ¢Tacisrm) 

Churnd, Fes 
(Bw, Color} 

We = NORTH WIND 

& = SOUTH WIND 

x = EAST WIND 

We = WESTWIND 

‘p = RED DRAGON 

pan = GREEN DRAGON 
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Puned 

re, 

b 
v4 

he 

> 
$ 
Makice. 

(Bw Only) 

= JERA ¢Haresth 

=ALGI?Z (Protection) 

=DAGAZ (Breakthrough) 

= PERTH ¢Inificton} 

= WUNIO (Joy 

= SOWELU (wholeness) 

(Bw Only) 
Th = Weep 

qD 

© De On Ht 

= NITRIC ACID 

= BRIMSTONE 

= ANTIMONY 

= SILVER 

= SOLD 



st) 

Cheag Hebrers/ 
(BW Only) (BW Only) 

qlp = KING mM = ALEPH 

Wy = QUEEN ) = BETH 

‘= ROOK (Castle) eee 

@ = sIsHOP “| = DALETH 

@ = KNIGHT<Horse} =| = HEH 

Z = Pawn T= VAHV 

Resnded 
(Bw Only) (Color Only) 

@& = PYRAMID h = OSTRICH FEATHER 
(Heavenly Are) (Truth, justices 

3 

av 
@ 
: 

= COBRA ‘Ascension ff} = SCARAB (The sun} 

= UTCHAT (Heath) = AHNK (Life) 
= HEHA = FALCON 
(Fox, divine protection} ld (he God Horus, power 

= HORUS 4 : = UWPLIFTIED ARMS 

(Falcon, power (The soul 

= ANKH ¢Life) ff) =3 FOX SKINS (weatthy 
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Strat nto Inner Sheaseed 
(Bw, Calor) (Bw, Color} 

= THUNDERBIRD Me = SQUARE 
(Unlimited happiness) (Logic, balance 

= SUN <Light) @ = cIRCLE 
CSpinual, wholeness> 

13) = BUTTERFLY A = TRIANGLE 
(Life everlasting) (Creative, change? 

aie 

= —- DIAMOND 
ge oe th a (Prospenty, The 4 Directions) 

@® = BUFFALO @ = HEART (Love. compassion) 
(srect Provider 

A = ARROWHEAD Se = PENTACLE 
(Alemess) (Protection, excellence) 

New Axe 
(Bw Only) 

hey = SHINING BRIGHT 
(Sun & Moon) 

& = HEAVEN ABOVE 

et = THE PROVIDER 

(0) = SPIRIT 

= GREAT SPIRIT 
c EVERYWHERE 

fo" = GREAT SPIRIT 
ABOVE 
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mBOUT THE CALLIGRAPHY 

Page 1 The Primal (Chinese) 

Page 18 Abundance (Chinese) 

Page 56 The Offering (Chinese) 

PALLIGRAPHY AND PICTURE CREDITS 

rage 7 Original Calligraphy by Eido Shimano-roshi 

Cover The Mustard Seed Garden Manual of Chinese Painting 
Translated and Edited by Mai-mai Sze 
Princeton University Press, Princeton, New Jersey, 1963 

Copyright 1956 by the Bollingen Foundation, Inc. 

Pages 1, 27,46, The Illustrated I Ching 
BZ, 56 by R.L. Wing 

Doubleday/Dolphin, New York, N.Y. 
Calligraphy by Shun Yu 
Copyright 1982 by Immedia 

Page 18 Chinese Symbolism and Art Motifs 
by C.A.S. Williams 
Charles E. Tuttle Company, Inc. 
Rutland, Vermont & Tokyo, Japan, 1974 
Copyright 1974 by Charles E. Tuttle Company, Inc. 
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ACCOLADE CUSTOMER SERVICE: (408) 296-8400 
If you need help with this — or any other — Accolade product, please give us a call between 
the hours of 8am and 5pm (Pacific Standard Time). Be sure you are at your computer when 
you call. We'll do everything we can to solve your problem or answer your question. Or write 
to us at: 

Accolade 
Attn: Customer Service 

550 S. Winchester Blvd., Suite 200 
San Jose, CA 95128 

If you have a modem, you can call and log-on to Accolade’s Bulletin Board for instant hints 
and other information. You can also leave questions about any Accolade game; they’ll be 
answered by Accolade’s technical support representatives. The number is 408-296-8800. Our 
settings are 300, 1200, 2400 baud; 8 Data; No Parity; 1 Stop Bit. 

DO YOU WANT TO BACK-UP YOUR DISK? 
We know you’re concerned about disk damage or failure. So feel free to make a back up of the 
game. See your computer manual for details about saving disks. If you lose the off-disk copy 
protection scheme, please send us $15 and we’ll send you a new one. If it’s destroyed, send us 
the remains, and we'll give you a replacement. 

YOUR DISK CARRIES A 90-DAY WARRANTY 
Accolade, Inc. warrants for a period of 90 days from the date of purchase by the original 
purchaser of the Software that the recording medium on which it is recorded will be free from 
defects in materials and workmanship. Defective media which has not been subjected to 
misuse, excessive wear or damage due to carelessness may be returned during the 90-day period 
without charge. 

After the 90-day period, defective media may be replaced in the United States for $10 (plus 
7.25% sales tax if the purchaser resides in California). Make checks payable to Accolade, Inc. 
and return to the address above. (To speed up processing, return only the disk, not other 
materials. ) 

LICENSE AGREEMENT and LEGAL MUMBO JUMBO 
This computer software product (the “Software”) and the user manual are provided to the 
Customer under license from Accolade, Inc. and are subject to the following terms and 
conditions, to which the Customer agrees by opening the package of the Software and user 
manual and/or using the Software. Granting of this license does not transfer any right, title or 
interest in the Software or the user manual to the Customer except as expressly set forth in 
this License Agreement. 

The software and the user manual are copyrighted 1990 by Accolade, Inc. All rights are 
reserved. Neither the Software nor the user manual may be duplicated or copied for any 
reason. The customer may not transfer or resell the Software or user manual. All registered 
trademarks and names are properties of their respective owners. 

The remedies provided above are the Customer’s sole and exclusive remedies. In no event 
shall Accolade, Inc. be liable for any direct, indirect, special, incidental or consequential 
damages with respect to the Software or the user manual. Except as provided above, 
Accolade, Inc. makes no warranties, either express or implied, with respect to the Software or 
the user manual, and expressly disclaims all implied warranties, including, without limitation, 
the warranty of merchantability and of fitness for a particular purpose. 

Game © 1989, 1990 Michael Feinberg and Software Resources International. 

Ishid6 is a trademark of Publishing International. 

All other materials © 1990 Accolade, Inc. The product names mentioned in this manual are the 
trademarks or registered trademarks of their manufacturers. 

\CCco’ ART 
TULL UL. 05154C 
The best in entertainment software.” 9/90 



‘Madintoshisia 
* ame 1989/90, Mi 













\|
 

40
7 

En
vi
si
on
 





> 

ae 

soun 


